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NOTICE INVITING TENDER (NIT) 
FOR SUPPLY, INSTALLATION, TESTING AND 

COMMISSIONING (SITC) AND NON COMPREHENSIVE 
AMC OF ADDRESSABLE FIRE ALARM SYSTEM AT 

BANK’S STAR HOUSE-I BUILDING AT MUMBAI 
 
 

 
Event No-BOI/Mumbai/Premises/1/25-26/ET/1/[SITC AND AMC FIRE ALARM SYSTEM]   
 

Last date of the bid submission: - 09 May 2025; 1.00 PM  
 

 

Name of the firm  ……………………………….. 

Address                  ...……………………………... 

……………………………….. 

……………………………….. 

 

Phone Numbers – ……………………………….. 

Mobile No.  ………………………………..  
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Head Office: Star House, Plot: C-5, “G” Block, 
Bandra Kurla Complex, Bandra (East), Mumbai 400 051 

Ph: 022 6668 4415/17, E-mail: Headoffice.Security@bankofindia.co.in 

1. GENERAL 

Bank of India, Head Office, invites e-tender in a two-bid system (Technical & Financial) 
from experienced and eligible bidders for Supply, Installation, Testing and Commissioning 
(SITC) and Non Comprehensive AMC of Addressable Fire Alarm System at Bank’s 
Corporate building namely Star House-I situated at Bandra Kurla Complex, Mumbai. 

2. DISCLAIMER 
While the document has been prepared in good faith, no representation or warranty, 
express or implied, is or will be made, and no responsibility or liability will be accepted by 
Bank or any of its employees, in relation to the accuracy or completeness of this document 
and any liability thereof expressly disclaimed. No contractual obligation on behalf of Bank, 
whatsoever, shall arise from the offer process unless and until a formal contract is signed 
and executed by duly authorized officials of Bank and the Bidder. 

3. E-Tenders (Two Cover System), on item rate basis are to be submitted online at 
www.mstcecommerce.com/eproc . To facilitate the prospective bidders, detailed process 
and instructions to participate in MSTC e-Tender portal are provided in Annexure 
hereinafter. 

4. The bid documents consist of two parts. Part A i,e. Technical Bid  consists of product details, 
Terms & Conditions to be complied with, Forms of application, Prequalification Criteria etc. 
Part B i,e. Commercial Bid / Price Bid  consists of  Bill of Quantities. Detailed tender 
documents consisting of Technical Bid and Price Bid can be available on line at 
www.mstcecommerce.com/eproc/ and tender section in www.bankofindia.co.in  

5. However, the bids can be submitted only after deposition of the following amounts by NEFT 
in favour of MSTC and Bank of India as under within the period of bid submission: 

a. Tender Fee: Rs. 10000.00 (Ten Thousand only) – Non-refundable towards cost of 
Tender  and EMD of Rs. 1,50,000.00 ( Rupees One Lac Fifty Thousand)  in the name 
of Bank of India  in the following account 

 

Particulars NEFT/RTGS 

BANK NAME Bank of India 

BRANCH NAME Bandra Kurla Complex 

CITY Mumbai 

IFSC CODE BKID0000122 

ACCOUNT NO 01220SUNCR822 

BENEFICIARY NAME Estate Department, Collection Account 

b. Transaction Fees:. The applicants shall pay the transaction fee as applicable (non - 
refundable) to MSTC using “Transaction Fee Payment” Link under “My Menu” in the 
vendor login. The applicants have to select the particular tender from the event 
dropdown box. The vendor shall have the facility of making the payment either 
through NEFT or Online Payment. Bidders are advised to remit the transaction fee ell 
in advance before the closing time of the event so as to give themselves sufficient time 
to submit the bid. 

 (All Micro and Small Enterprises- MSEs having valid registration as per provisions of 
the Government of India Policy i.e. registration with District Industries Centre (DIC) or 
National Small Industries Commission (NSIC) or Udyog Aadhaar Memorandum or any 
other body specified by Ministry of MSME will be exempted from submission of EMD 
and Tender fee. MSE, must along with their offer / application, provide proof of their 

mailto:Headoffice.Security@bankofindia.co.in
http://www.mstcecommerce.com/eproc
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being registered as MSE (indicating the terminal validity date of their registration) for 
the item / goods / services tendered, with any of the agencies mentioned above, for 
claiming such exemption.) 

c. The last date of submission of tenders is up to 01.00 P.M. on 09-05-2025   Technical 
Bid will be opened at 3.00 P.M. on the same day i.e. on 09-05-2025  

d. All the applications will be scrutinized as per the prequalification criteria given in this 
document. Financial Bid / Price Bid of only those applicants/bidders who fulfil the 
Prequalification criteria, whose works are found satisfactory and against whom there is 
no adverse comments/reports from previous clients, will be opened.  The time and date 
of opening of the price bid will be intimated subsequently. Our endeavours will be to 
open the Price Bids of valid tenders at the earliest. 

e.  The bidders are requested to upload their queries, if any on MSTC portal on or before 
22-04-2025 till 5.00 PM. Pre-bid queries will be replied on the portal of MSTC. Bank 
of India reserves the right to accept or reject any or all the tenders/bid, without assigning 
any reasons whatsoever                                                                       

6. INSTRUCTIONS TO BIDDERS FOR E-TENDERING 

This is an E- Tender event of Bank of India and service provider is MSTC Ltd. 
Bidders are requested to read the process of E-Tender (sub para 6.1.A to 6.1.V), 
terms & conditions of this tender before submitting their online tenders. Bidders who 
do not comply with the conditions with documentary proof (wherever required) will not 
qualify in the Tender process for opening of Price bid / Commercial bid  

 6.1  PROCESS OF E-TENDER 

A. Registration of bidder- Any bidder willing to take part in the process of e-Tendering will 
have to be enrolled & registered with the MSTC e-Procurement system, through logging 
on to https://eprocure.gov.in/eprocure/app . The process involves Bidder’s registration 
with MSTC E-Procurement portal which is free of cost. Only after registration, the 
Bidder(s) can submit his/their bids electronically. Electronic Bidding for submission of 
Technical Bid as well as Commercial Bid will be done over the internet. The Bidder should 
possess Class III signing type digital certificate. Bidders have to make their own 
arrangement for bidding from a P.C. connected with Internet. MSTC is not responsible 
for making such arrangement. (Bids will not be recorded without Digital Signature).  

 SPECIAL NOTE: THE TECHNICAL BID AND COMMERCIAL BID HAVE TO BE  
 SUBMITTED ON-LINE AT www.mstcecommerce.com/eprocn/ (Version 3) 

i) Bidders are required to register themselves online with 
https://www.mstcecommerce.com/eprocn → Register (Filling up details and creating 
own user id and password) → Submit. Please follow the ‘Registration Guide’ available 
in the Registration link before proceeding.(go to Download Guide/ Video/ Registration) 

ii) Bidders will receive a system generated mail confirming their registration in their email 
which has been provided during filling the registration form.  

iii) The bidders shall have to subscribe to the buyers and categories in order to receive 
system generated mails. In order to subscribe, a Bidder has to login and click on ‘My 
Subscription’ followed by ‘Add Subscription’. On successful subscription, a system 
generated mail shall be forwarded to the Bidder. Please follow the guide for 
‘Subscription’ of ‘Download Guides’ available in the Dashboard before proceeding. In 
case of any clarification, please contact BANK OF INDIA/MSTC, (before the scheduled 
time of the e- tender) 

Contact Details (BANK OF INDIA)  

 Tel. No. – 022-66684414/17/15/16 

 Email- HeadOffice.Security@bankofindia.co.in 

https://eprocure.gov.in/eprocure/app
http://www.mstcecommerce.com/eprocn/
mailto:HeadOffice.Security@bankofindia.co.in
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Contact Details (MSTC Ltd) 

 Centralized MSTC Helpdesk no (for Technical Guidance) - 07969066600 

 Email - helpdeskho@mstcindia.in   

Please mention “HO Helpdesk” as subject while sending  e-mails (9.30 AM to 5.00 PM on 
all working days for all Technical issues e-tenders, System setting etc.) 

 WRO Helpdesk:- 7651915418/02269856817/02269856800 

 

i. Mr. Tanmoy Sarkar, Designation: Deputy Manager 

        Tel No: 8349894664; E-mail: tsarkar@mstcindia.co.in 

 

B. Digital Signature certificate (DSC):- Each bidder is required to obtain a Class-III Digital 
Signature Certificate (DSC) for submission of bids. The bidder can search and download 
NIT & Tender Documents electronically from the website www.mstcecommerce.com using 
the Digital Signature Certificate. This is the only mode of collection of Tender Documents  

 

C. System Requirement  

 
i) Operating System –Windows 11 and above  
ii) Web Browser- Preferred ‘IE 8’ and above 
iii) Web Browser- Preferred ‘IE 8’ and above  

i) Tools=>Internet Options=>Security=>Disable protected Mode If enabled-i.e., 
Remove the tick from the box mentioning “Enable Protected Mode”.  

ii) Tools => Internet Options => Security =>Custom Level=>  

 Active X control & plug-ins: Enable all Active-X Controls  

 Scripting: Enable “Allow Status Bar Update Via Script”  

 Disable “Use Pop-up Blocker”  
iv) Java: JRE 8 Latest update  
v) Other Settings  

i) View => Toolbars=> “Tick” Status Bar.  
ii) Tools=>Internet Options=> General=> Click on Settings under “Browsing 

history/Delete Browsing History”=> Temporary Internet Files=>Activate “Every time 
I Visit the Webpage”.  

vi) For new Version of IE or other “Active –X Filtering” under Tools should not be ticked.  
vii) Tools =>Internet Options=> Security=> Selected Trusted Sites=> Add Website 

https://www.mstcecommerce.com . 
 

mailto:helpdeskho@mstcindia.in
mailto:tsarkar@mstcindia.co.in
http://www.mstcecommerce.com/
https://www.mstcecommerce.com/
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D.    All entries in the tender should be entered in online Technical & Commercial Formats 
 without any ambiguity  

E.   Special Note towards deposition of EMD, Cost of Tender and Transaction fee 
1) Rs. 10000/- towards cost of tender  and Rs. 1,50,000.00 towards EMD in the name 

of Bank of India in the following account 

Particulars NEFT/RTGS 

BANK NAME Bank of India 

BRANCH NAME Bandra Kurla Complex 

CITY Mumbai 

IFSC CODE BKID0000122 

ACCOUNT NO 01220SUNCR822 

BENEFICIARY NAME Estate Department, Collection Account 

 

2) Transaction Fee (non-refundable) to MSTC Ltd: The bidders shall pay the 
transaction fee (non - refundable) using “Transaction Fee Payment” Link under 
“My Menu” in the vendor login. The bidders have to select the particular tender 
from the “event catalog” through their login. The vendor shall have the facility of 
making the payment either through NEFT or Online Payment. On selecting NEFT, 
Service Provider / Contractor / Vendor shall generate a challan by filling up a form. 
Service Provider / Contractor / Vendor shall remit the transaction fee amount as 
per the details printed on the challan without making change in the same. On 
selecting Online Payment, Service Provider / Contractor / Vendor shall have the 
provision of making payment using its Credit / Debit Card / Net Banking. Once the 
payment gets credited to MSTC’s designated bank account, the transaction fee 
shall be auto authorized. Bidders are advised to remit the transaction fee well in 
advance before the closing time of the event so as to give themselves sufficient 
time to submit the bid. 

  

NOTE:  

 Transaction fee is non-refundable. A vendor will not have the access to 
online e- tender without payment of the transaction fee. 

 The bidders should submit the EMD, Cost of Tender and transaction fee (ON 
OR BEFORE THE PRESCRIBED DATE) as they will be authorized for bid 
submission only after receipt of the same by Bank of India and MSTC.  

 After depositing the amounts mentioned above, prospective bidders are 
required to send an email in this regard to below email ids stating the 
transaction details viz Amount, Date of Transfer, UTR No., bank etc.  

Contact Details (BANK OF INDIA) 

  Tel. No. – 022-66684414/17/15/16 

  Email- HeadOffice.Security@bankofindia.co.in 

 

Contact Details (MSTC Ltd)  

i. Mr. Tanmoy Sarkar 

 Designation: Deputy Manager 

       Tel No: 8349894664 

       E-mail: tsarkar@mstcindia.co.in 

 Bidders may please note that the Cost of Tender, EMD and transaction fee should be 
deposited by debiting the A/C of the bidder only. These amounts if deposited from or 
by debiting any other a/c will not be accepted. Cost of Tender and Transaction fee is 
non-refundable.  

mailto:HeadOffice.Security@bankofindia.co.in
mailto:tsarkar@mstcindia.co.in
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 In case of failure to submit the payment towards Cost of Tender and Transaction fee 
for any reason, the Bidder will not have the access to online E-Tender. 

 All notices and correspondence to the bidder(s) shall be sent by email only during the 
process, up to the finalization of tender by Bank of India. Hence the bidders are required 
to ensure that their official email ID provided is valid and updated at the stage of 
registration of vendor with MSTC (i.e. Service Provider). Bidders are also requested to 
ensure validity of their DSCs (Digital Signature Certificates). 

F.  E-Tender cannot be accessed after the due date and time mentioned in NIT (Notice Inviting 

Tender).  

 

G.  Bidding in E-Tender 

i)  The process involves Electronic Bidding for submission of Bid.  

ii)  The bidder(s) can submit their Bid through internet in MSTC Website 

 www.mstcecommerce.com/eproc  

iii) The NIT/ Documents shall be available for download in the event catalogue 

 available under ‘Event catalog’ of the Event.  

iv) Please follow the guides for ‘Uploading encryption public key’ and ‘Bidding’ under 

‘Download Guides’ available in the Dashboard before proceeding to submit bid. 

 Technical bid to contain the notice inviting applications, application form duly filled in 

with all supporting documents fulfilling requisite selection criteria/ General Conditions of 

the tender, instruction to the applicants etc. Financial bid to contain priced Bill of 

quantities in the prescribed format. 

v) The bidders may upload the bid related documents in the link ‘Upload Documents’ in 

My menu. Multiple documents can be uploaded. Maximum size of single document for 

upload is 5 MB. 

vi) Once documents are uploaded in the library, vendors can attach documents through 
 Attach Document link against the particular e-Tender .Please note that if the 
 documents are not attached to any e-Tender, the same cannot be downloaded by 
 Bank of India and it will be deemed that the vendor has not submitted the documents .
 For further assistance please follow instructions of vendor guide. 

 
a) Bidder(s )need to submit necessary EMD, E-Tender fees (If ANY )and Transaction fee 

separately for the e-tender .Transaction fees if any are non-refundable .No interest will 

be paid on EMD .EMD of the unsuccessful bidder(s )will be refunded by Bank of India.  

The bidders )who have submitted the above fees can only submit their Bid and Price Bid 
through internet in MSTC website www.mstcecommerce.com → e-procurement  →New 
Common Portal  →Bid Floor Manager →live event →Selection of the live event →Transaction 
fee->Common terms->Attach Documents->Price Bid . 
 
Please Note: The vendor after successful remittance of the transaction fees and EMD details, 
will get the attach documents and common terms tab enabled in their login. Post successful 
completion of this step, the vendors will be allowed to save the lot specific terms and submit 
their price bid against the lot through the portal or download and upload the excel file for 
submitting price bids, as the case may be. In case the attach documents and/or saving common 
terms step is unsuccessful, the tabs for saving lot specific terms and submitting price bid would 
be disabled. The status of whether the same is successful/pending would be displayed in the 
bid status button.  

http://www.mstcecommerce.com/eproc
http://www.mstcindia.com/
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b) First the vendor needs to fill up the Technical bid .After filling the Technical Bid, bidder 

should click ‘save ’for recording their bid .Once the same is done, the Price Bid link 

becomes active and the same has to filled up and then bidder should click on “save ”to 

record their price bid .Then once both the bids has been saved, the bidder can click on 

the “Final Submission ”button to register their bid 

 NOTE  :- After clicking the final submission “Delete bid” option would be shown  .If the 

 vendor wants to delete the bid after final submission and re submit the bid, then 

 he/she should click delete bid and resubmit the same and again click final submission. 

vi)  In all cases, bidder should use their own ID and Password along with Digital 

 Signature at the time of submission of their bid.  

vii) During the entire e-tender process, the bidders will remain completely anonymous to 

one another and also to everybody else.  

viii) The e-tender floor shall remain open from the pre-announced date & time and for the 

duration mentioned above.  

ix) All electronic bids submitted during the e-tender process shall be legally binding on the 

bidder. Any bid will be considered as the valid bid offered by that bidder and acceptance 

of the same by Buyer will form a binding contract between Buyer and the Bidder for 

execution of work. Such successful tenderer shall be called hereafter 

SUPPLIER/CONTRACTOR.  

x) It is mandatory that all the bids are submitted with digital signature with class III signing 

and encryption type of digital signature certificate otherwise the same will not be 

accepted by the system.  

xi) Buyer reserves the right to cancel or reject or accept or withdraw or extend the tender 

in full or part as the case may be without assigning any reason thereof.  

xii) No deviation of the terms and conditions of the tender document is acceptable. 

 Submission of bid in the e-tender floor by any bidder confirms his acceptance of terms 

& conditions for the tender.  

xiii) Unit of Measure (UOM) is indicated in the e-tender Floor. Rate to be quoted should be 

in Indian Rupee as per UOM indicated in the e-tender floor/tender document. 

H.  Any order resulting from this e-tender shall be governed by the terms and conditions 

 mentioned therein. 

I.  No deviation to the terms & conditions are allowed. 

J.  Bank has the right to cancel this e-tender or extend the due date of receipt of bid(s) 

 without assigning any reason thereof. 

K.  The online tender should be submitted strictly as per the terms and conditions and 

 procedures laid down in the website www.mstcecommerce.com/eproc of MSTC Ltd. 

L.  The bidders should upload all the documents required (if any) as per terms of NIT. Any 

 other document uploaded which is not required as per the terms of the NIT shall not be 

 considered. 

M.  The tenders will be opened electronically on specified date and time as given in the NIT. 

 Part I Technical bid will be opened electronically on specified date and time as given in 

 the NIT. Bidder(s) can witness electronic opening of bid. Technical Bid part of the 
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 applications will be scrutinized by the Bank as per the bench mark of minimum eligibility 

 / selection criteria given in the Notice.  Works executed under  the consultancy by the 

 firms who fulfil the eligibility criteria will be inspected by an in-house Committee of the 

 Bank.  Confidential reports from the previous clients of the firms who fulfil the minimum 

 eligibility criteria  will be  obtained by the Bank. Based on the fulfilment of 

 selection/eligibility criteria, inspection of works and confidential reports, short listing of 

 contractors will be  done for opening the financial bids. 

N.  Letters / e-mails will be issued to the shortlisted contractors informing that they have 
 been pre-qualified based on Technical parameters as well as the date fixed for opening 
 their financial bids. Applicants who are not shortlisted will also be intimated with reasons 
 for their non-selection.   

O.  Commercial bids / Price Bids of the shortlisted / technically qualified bidders will  be 
opened electronically by the Bank on the date as intimated to them. 

P.  If the space in this form is insufficient for furnishing full details, such information may be 
 continued on separate sheets of paper, stating therein the part of the form and serial 
 number. Separate sheets shall be used for each part and a proper reference with page 
 number must be indicated in the main form of application. 

Q.  Applications containing false and/or inadequate information are liable for   rejection. 

R.   Clarifications, if any required, may be obtained from Head Office Security Department, 
 Bank of India  

S.  Bidders are requested to visit the site before submitting the application to acquaint   
 themselves with the site conditions.  

T.   Decision of the Bank in regard to selection of contractor for the work shall be final. The 
 Bank reserves the right to reject any or all applications without assigning any reason 
 thereto. 

U.   Canvassing in any form in connection with the Tender is strictly prohibited and the bids 
 submitted by the bidders who resort to canvassing are liable to be rejected.  

V.   The bidders shall quote their rate EXCLUDING GST. GST SHALL BE PAID EXTRA 

 as per rule. If the bidder fails to pay the taxes to the authorities concerned, the 

 owner reserves the rights to recover the said amount from the amount payable to the 

concerned authorities.  If rates are quoted in any other format as mentioned above, their 

bid will not be considered and will be out rightly rejected.  

 Note: bidders/ tenderer must submit the tender as per original format. If any bidder 

changes any format of technical bid, price bid, or any part of tender at any stage of 

tendering/ bidding, his bid will not be considered and his tender/ bid will be out rightly 

rejected. If bidder makes any remarks or any condition, his bid will not be considered 

and his tender/ bid will be rejected. Tenderer must not revise, add, omit, or assume 

anything other than detailed in tender. No justification whatever may be considered in 

this regard. 

7. SCHEDULE 

7.1 The following is an indicative timeframe for the overall process. Changes to the 
time frame, if any, shall be communicated to the Respondents during the process by 
publishing addendums on Bank’s website: 

E-Tender Reference    Details 
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Price of E-Tender Document  Rs.10,000.00 (Non Refundable) 

Refundable EMD (Interest Free)  Rs. 1,50,000.00  

Estimated Cost  Rs. 60,00,000.00 

Date of commencement of issue of E-
Tender Document 

 17 April 2025 

Period for submission of Pre-bid query 
through MSTC  

 18th April 2025 to 22nd April 2025, 05.00 
PM 

Last Date & Time for receipt of E-Tender 
offers 

 09 May 2025, 01.00 PM 

Date of opening of Technical bids  09 May 2025, 03.00 PM 

Date of opening of Financial bids 
(Only for Technically Qualified bidders) 

To be intimated later to technically qualified 
bidders only 

Address  for Communication  The Chief Security Officer  
 Bank of India, ‘Star House-I’  
 Head Office, C-5, G-Block 
 Bandra-Kurla Complex, Mumbai 400051 

Telephone Contact Number 022-6668 4417/ 14/ 15/ 16 

E-mail Id Headoffice.security@bankofindia.co.in 

Website  www.bankofindia.co.in  

8. EVALUATION PROCESS  

8.1 Stage- I– Technical Evaluation 

Incomplete tender proposals not accompanied by the mandatory documents as 
mentioned under para 12 i.e. ‘Details required to be Submitted’, cost of application 
and EMD (unless exempted) shall be rejected. Offers will be evaluated for 
completeness of the technical bid in all respects as laid down in tender document. 
Technical Evaluation will be done by a Committee based on details provided in 
various Appendices of this Bid Document. The Bank reserves the right to seek 
clarifications from an applicant/ his references if the proposal has any ambiguous 
submissions before accepting or rejecting the proposal in order to give the applicant 
fair chance to clarify the submissions made in the proposal. 

8.2 Stage-II – Financial Bids: Financial Bid is to be submitted in the specified format 
uploaded on MSTC portal. Financial Bids of only technically qualified bidders shall be 
opened through MSTC Website on a date which shall be intimated to the eligible 
bidders after scrutiny of the technical bids. 

9. LAST DATE FOR SUBMISSION OF THE TENDER 

Tender along with the documents (as mentioned under Para 12-Details required to be 
submitted) should be uploaded/submitted latest by 1.00 pm on 09-05-2025 on MSTC 
website. The E-Tender will be opened on the same day at 3.00 pm. 

 
10. ELIGIBILITY CRITERIA FOR APPLICANTS 

The bidder must fulfill following qualification criteria to be eligible to bid:  
a) The bidder could be a sole proprietary concern/ partnership firm or a company duly 

registered with appropriate authority 
b) The Bidder should be a registered Company/ Firm in India and having a registered 

Branch Office/ Service Centre in Maharashtra. 
c) The bidder should be an Income Tax Assesse. 
d) The average turnover during the last three financial years should be at least Rs. 100.00 

Lakh. 

mailto:Headoffice.security@bankofindia.co.in
http://www.bankofindia.co.in/
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e) Experience: The bidder/ firm must have at least 5 (five) years’ experience in Supply, 
Installation, Testing and Commissioning (SITC) and Maintenance of Addressable Fire 
Alarm System as on 01st March 2025 in Government Sector/ PSUs /Nationalized 
Banks/ Private Banks/ Establishments/ Private Firms. 

 
f) Work Performance for eligibility 
 

i) The Bidder/Firm must have executed at least three (3) work contract for Supply, 
Installation, Testing and Commissioning (SITC) of Addressable Fire Alarm 
System in Government/ PSUs/ Nationalized Banks/ Private Banks/ 
Establishments/ Private firms of value not less than Rs. 24 Lakh each   

OR 
The Bidder/Firm must have executed at least two (2) work contract for Supply, 
 Installation, Testing and Commissioning (SITC) of Addressable Fire Alarm 
 System in the Government/ PSUs/ Nationalized Banks/ Private Banks/ 
Establishments/ Private firms of value not less than Rs. 30 Lakh each 

OR 
 The Bidder/Firm must have executed at least one (1) work contract for Supply, 
 Installation, Testing and Commissioning (SITC) of Addressable Fire Alarm 
 System in the Government/ PSUs/ Nationalized Banks/ Private Banks/ 
Establishments/ Private firms of value not less than Rs. 48 Lakh each 

 (Certificates from the client(s) where the SITC of Fire Alarm system has been 
done to be submitted in the format mentioned in Appendix-D.) 

ii) The Bidder/ Firm must have at least two (2) running contract for Maintenance of 
Addressable Fire Alarm System in Government / PSUs/ Nationalized Bank/ 
Private Banks/ Establishments/ Private Firms amounting to at least Rs. 
1,00,000.00 each as on 01st March 2025. 

(Certificate from the Clients where the AMC contract is in currency to be 
submitted in format given in Appendix-E.)   

g) The bidder should not have been blacklisted/ debarred for corrupt and/ or fraudulent 
practices by any Government / PSUs organizations in last 3 years.  

(Declaration to the effect to be submitted in format as given in Appendix-F.) 

h) The company/ firm/ bidder should have valid GST and PAN registration. The agency 
should be registered with EPFO, ESIC etc as applicable. 

i) The bidder should have valid License from Maharashtra Fire Service for doing Fire 
Alarm Installation Work in Maharashtra. 

 
11. PRODUCTS TO BE SUPPLIED AND INSTALLED 

Specifications along with Make and model details of the Addressable Fire Alarm Panel and 
other components has been listed on para 1.7 under Appendix-C “Technical details of Fire 
Alarm System”.  

12. Details along with documentary proof required to be submitted 
12.1 Technical bid: The technical bid document shall contain the following and should be 

uploaded/submitted on MSTC website under Part A –Technical Bid “Tender for 
Supply, Installation, Testing and Commissioning (SITC) and Non 
Comprehensive AMC of Addressable Fire Alarm System at Bank’s Star House-
I building”. The sections for uploading/submission are as under:  

a) MSTC Annexure 1 – Appendix – A  (Applicant’s profile) 
b) MSTC Annexure 2 – Signed & stamped copy of the Tender document including 

Appx-B & C 
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c) MSTC Annexure 3 – All documents related to pre-qualification of Technical Bid 
i) Proof of constitution and registration of the firm with appropriate authority. 
ii) Document in support of local Branch Office / Service Centre in Mumbai / 

Navi Mumbai / Thane regions. 
iii) Audited / Self certified, as applicable, Financial Statements along with 

Balance Sheet & PL Statement of last two FYs OR CA Certificate (with 
UDIN) on average Turn Over during last two years. 

iv) GST Registration Certificate 
v) PAN Card 
vi) Certificates from Clients (Appendix D & E) along with copies of relevant work 

orders. 
vii) Copy of license from Maharashtra Fire Service. 
viii) Manufacturer’s Authorization Form (MAF) 

 
d) MSTC Annexure 4 – Proof of payment of / exemption from payment of Tender 

Fee/EMD 
e) MSTC Annexure 5 – Any other document. 

  
12.2 Financial Bid: The financial bid has to be submitted on MSTC portal in the prescribed 

excel file. The excel file has three sheets namely “BOQ”, “Abstract” and “Summary 
Sheet”. The bidder has to quote their rates of various items in the unlocked rate field 
of “BOQ” sheet and the pricing will be auto-calculated. The abstract of prices under 
various subhead and final quote will be available for viewing in “Abstract” and 
“Summary sheets” only. The final price as calculated and viewed in the summary 
sheet will be considered for deciding the lowest bidder. The financial bid format has 
been reproduced in Annexure-I of this document for reference. 
  

12.3 Please ensure that Financial Bid is in way uploaded in any form in technical bid 
section failing which the bid will be summarily rejected.  

 
13. MANUFACTURING AUTHORIZATION FORM (MAF) 

13.1 Applicant shall submit a letter that they are an authorized partner of the OEM of Fire 
Alarm System. 

13.2 Applicant shall be fully responsible for the manufacturer’s warranty in respect of 
proper design, quality and workmanship of all equipment, accessories, etc. The 
installed systems shall be under Comprehensive Replacement Warranty from date of 
handover the system for one year within which the bidder will ensure 4 quarterly 
preventive maintenance visits and any number of free of cost visits for repair/ 
replacement/ on call visit required to keep the system functional.  

14. WARRANTY 

Applicant shall be fully responsible for the manufacturer’s warranty in respect of proper 
design, quality and workmanship of all equipment, accessories, etc. The installed systems 
shall be under Comprehensive Replacement Warranty for one year within which the bidder 
will ensure periodical preventive maintenance to keep the system healthy and functional. 
Any number of free of cost visits for repair/ replacement/ on call visit required to keep the 
system functional during the defect liability period.   

15. ANNUAL MAINTENANCE CONTRACT 

The selected applicant shall be required to undertake the Annual Maintenance Contract for 
the Addressable Fire Alarm System being installed in the premises for a period of three 
years post warranty period. For the first year the system shall be covered under 
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comprehensive replacement warranty as per para 14 above. For the subsequent three 
years the system shall be covered under non-comprehensive Annual Maintenance 
Contract which will entail 36 monthly maintenance visits. The Annual Maintenance 
Contract shall be reviewed periodically and the contract may be terminated during the 
contract period with a 30(thirty) day notice period, if services are not found to be 
satisfactory. 

16. PRE BID QUERIES 

The Pre-bid queries should be submitted on or before 22-04-2025 by 05.00 pm through 
MSTC website. It may be noted that no queries from any bidder shall be entertained or 
received after the above mentioned date. Queries raised by the prospective bidder and the 
Bank’s response will be communicated through MSTC website only. No physical pre-bid 
meeting will be conducted. Relaxation in any of the terms contained in the Bid, in general, 
will not be permitted, but if granted, after Pre-Bid Queries, the same will be communicated 
through the corrigenda uploaded on MSTC website/Bank’s website only. 

 

17. SITE VISIT AND MEASUREMENT  

The bidder firm may/ should visit the site and understand the Scope of work, maintenance, 
site condition, existing set-up and hook-ups to be done at the site before making the price 
bid. Non familiarization of site condition shall not be considered for late execution of the 
work & not for the cost-overrun for the specified contract. Any bidder can visit the site during 
working hours between the period of 28-04-2025 to 05-05-2025 for measurement after due 
permission from Bank. 

 

18. GENERAL INSTRUCTIONS/CONDITIONS  

a) Please read the terms and conditions carefully before filling the application form.  
b) Please sign all the pages of the tender document including each page of the 

Application form. 
c) The Bid prepared by the Bidder, as well as correspondence and documents relating 

to the bid exchanged by the Bidder and the Bank and supporting documents and 
printed literature shall be written in English.  

d) Any type of formation of consortium, sub-contracting or joint assignments/work will 
not be allowed/considered. Such proposals will be disqualified. 

e) At any time prior to the deadline for submission of Bids, the Ban, for any reason, 
whether, at its own initiative or in response to a clarification requested by a 
prospective Bidder, may modify the Bidding Document/s, by amendment. 

f) The Bank reserves all rights to:  

i) Accept or reject the application either in whole or in part.  
ii) Reject any or all the applications partially or wholly.  
iii) Cancel or withdraw this tender.  
iv) Accept or reject any deviation from these conditions.  

 
19.  Validity of Offer –All the offers submitted by the bidders will be valid for 180 days from 

 date of opening of financial bids. 
  

                                                                                                        
            AGM & CSO 
          Bank of India 
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Appendix-A 

APPLICANT’S PROFILE 

Sr Item Particulars/ Details 

1 Name of the Applicant   

2 Status of Applicant - Proprietorship/ 
Partnership/Company/etc. 

 Enclose registration document indicating 
constitution and date of establishment 

3 Date of Establishment 

4 Name of the Proprietor / Partners / 
Directors with contact details incl e-
mail ID 

Name(s) - 
Designation- 
Contact No.-                              , Email ID- 

5 Address of Registered Office 
With Phone No. & Email Id. 

 

6 Address of Branch/Service centre in 
Maharashtra with Phone No. & Email 
Id 

 

7 PAN Details Enclose copy 

8 GST Registration Details Enclose copy 

9 EPF Registration details Enclose Copy 

10 ESIC Registration details Enclose copy 

11 Turn over (Enclose Financial 
statements/CA Certificate) 

2021-22- 
2022-23 - 
2023-24 - 

12 Contact details of the clients where SITC 
of Fire Alarm has been completed in last 
three years. These clients will be 
contacted for confirmation on the quality 
of work and performance 

Description Client 1 Client 2 Client 3 

Name of the Client    

Address    

Contact Person    

Contact Number    

e-mail ID    
 

13 Contact details of the clients where AMC 
of the Fire Alarm System is in currency. 
These clients will be contacted for 
confirmation on the service quality and 
performance 

Description Client 1 Client 2 

Name of the Client   

Address   

Contact Person   

Contact Number   

e-mail ID   
 

14 Details of License issued by 
Maharashtra Fire Services 

Enclose Copy 

15 Details of Tender application fee Details of payment receipt such as NEFT, UTR 
No. , Bank Details for payment of Tender 
Fee/Exemption Certificate for MSMEs  

16 Details of EMD Payment Details of payment receipt such as NEFT, UTR 
No. , Bank Details for payment of Tender 
Fee/Exemption Certificate for MSMEs 

17 Details of Projects completed during last three years to include details of the client, 
nature of work, value of the contract, stage of completion & dispute, if any.  
(Enclose copies of work order, progress/completion certificates) 

A  

B  

C  

18 Details of projects where AMC is currently valid/ ongoing (Client details, contract period & value) 

A   
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B   

 
Appendix-B 

Draft Agreement 
(Non-Judicial Stamp Paper of appropriate value) 

 
This Agreement made on this ______________ day of ____________2025 at 

__________________ between Bank of India a body corporate constituted under the Banking 
Companies (Acquisition & Transfer of Undertakings) Act, 1970 having its Head Office at Star 
House, C-5, ‘G’ Block, Bandra-Kurla Complex, Bandra (East), Mumbai 400 051 (hereinafter 
referred to as the ‘Bank’ which expression shall include its successors and assigns). 
AND 
M/s. ________________________________________ a Company registered under the 
Companies Act, 1956/Partnership firm/Proprietorship concern (delete whichever not 
applicable), having its registered office at __________________________________________ 
(hereinafter referred as ‘Vendor’ which expression shall include its successors and assigns). 
AND 
THIS AGREEMENT WITNESSETH AS UNDER 
 
WHEREAS The Bank is inter alia engaged in the business of banking and has various gadgets 
including Fire Alarm System installed in its Head Office Building at Bank of India, Star House, 
C-5, G Block, Bandra Kurla Complex, Mumbai for safety and security of the building,   
AND 
WHEREAS, M/s. .......................................has been contracted for Supply, Installation, Testing 
and Commissioning (SITC) and Non Comprehensive AMC of Addressable Fire Alarm System 
at Bank of India, Star House, C-5, G Block, Bandra Kurla Complex, Mumbai  
 
NOW THEREFORE, in consideration of the mutual covenants, undertaking and conditions set 
forth below and for other valid consideration the acceptability and sufficiency of which are 
hereby acknowledged the Parties hereby agreed as follows: 
 
1. Terms and Conditions 
 

1.1 THE SCOPE OF WORK shall include supply, deliver at site, any other services 
associated with the delivery of Fire Alarm System and its peripherals and Installation, 
cabling, testing, commissioning, providing warranty for the Addressable Fire Alarm 
System and post warrant services (i.e. Annual Maintenance Contract) and any other 
related services for the efficient functioning of the system. 

1.2 Annual Maintenance Contract (AMC) of the Addressable Fire Alarm System installed- 
The vendor shall during the period of agreement/contract supply, install maintain the 
Addressable Fire Alarm System installed in Bank’s Head Office premises in good working 
condition and for the purpose shall provide the maintenance service. 

1.3 The vendor will carry out thorough check up, testing, cleaning, servicing, software/ patch 
update, inspection & maintenance and any other activity required to keep the system 
healthy and working condition during the contract period. The vendor shall follow the BIS 
2189 as an indicative standard to do the maintenance activity for the alarm system 

1.4 The installation has to be done in the operational office which entails that the 
cabling/installation work in office area shall be allowed to be undertaken only in in non-
working hours/holidays in consultation with Security/Estate Department of the Bank in 
order to ensure that no disruption of work/business takes place. The vendor may prepare 
and plan their manpower/ technical team accordingly. 
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1.5 The vendor will ensure the system healthy and functional during the defect liability period 
of one year and attend all on-call visits in case of any installation/ functioning issue of the 
system without any additional charge. There is no limitation on number of on-call visits in 
defect liability period.  

1.6 The gadgets supplied shall be brand new as per tender specification, original from the 
OEM, free from all defects and shall be of the highest grade and quality. VENDOR shall 
be fully responsible for its efficient operation and that no refurbished / duplicate / second 
hand gadgets or components shall be supplied or shall be used. In case of default and in 
case of the Bank finding that the above conditions are not complied with, the vendor will 
take back the gadgets supplied and return the money paid by the Bank, in full within seven 
days of intimation of the same by the Bank, without demur or any reference to a third 
party and without prejudice to any remedies the Bank may deem fit.  

1.7 In the event of any information/ details particulars proven to be incorrect or any details 
submitted turned out to be false during the tenure of SITC of Fire Alarm System and 
subsequent AMC, the Bank at its discretion may recover the cost of the equipment and 
may also forfeit the Security money deposit towards performance security and terminate 
the complete contract. The Vendor may further be debarred from participating in the 
bidding process for the next three (3) years in similar nature of work in the Bank. 

 
2. Duration of the Contract 
2.1 The Contract duration will be of four (04) years i.e from ______ 2025 to ___  2029 (i.e. 

from the date of handing over the system to the bank) unless terminated due to 
a) Vendor being not performed services as per Tender Terms & Conditions; and 
b) Breach of terms of contract as mentioned in this agreement hereinafter. 

 
3. Non-Disclosure Clause 
 

3.1 For the purpose of this agreement, the following definitions shall hold good 
 

3.1.1 "Confidential Information" means and includes all data, documents and 
information disclosed or to be disclosed by either Party to other Party and its 
Representatives (as defined herein) (including information transmitted in written, 
electronic, magnetic or other form and also information transmitted orally or 
visually) and any and all information, in whole or in part, directly or indirectly, from 
such information including all notes, summaries, analyses, compilations and 
other writings. Confidential information shall include any copy, abstract, extract, 
sample, note or module thereof and electronic material or records. 

3.1.2  Receiving Party means the party who receives the confidential information and 
is obligated to keep it secret “Receiving Party” may use the information solely for 
and in connection with the Purpose. 

 

3.1.3 "Disclosing Party" means party who discloses Confidential Information. 
 

3.2 It is hereby agreed by and between the parties hereto as follows: 
 

3.2.1 Use of Confidential Information - Each party agrees not to use the other’s 
confidential information for any purpose other than specified. Any other use of 
such confidential information by any party shall be made only upon the prior 
written consent from the authorized representative of the other party or pursuant 
to subsequent agreement between the Parties hereto. 

 

3.2.2 The receiving party shall not commercially use or disclose for commercial 
purpose any confidential information or any materials derived there from, to any 
other person or entity other than persons in the direct employment of the 
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Receiving Party who have a need to access to and knowledge of the confidential 
information solely for the purpose authorized above. The Receiving Party may 
disclose confidential information to consultants only if the consultant has 
executed non-disclosure agreement with the Receiving Party. 

 

3.2.3 The Receiving Party agrees to notify the Disclosing Party immediately if it learns 
of any use or disclosure of the Disclosing party’s confidential information in 
violation of the terms of this Agreement. 

 

3.2.4 Neither party shall make news release, public announcements, give interviews, 
issue or publish advertisements or Agreement, the contents/provisions thereof, 
other information relating to this agreement, the purpose, the Confidential 
information or other matter of this agreement, without the prior written approval 
of the other party. 

 
3.3 Exemptions 

3.3.1 The obligations imposed upon either party herein shall not apply to information, 
technical data or know how whether or not designated as confidential, that: 

a) Is already known to the Receiving party at the time of the disclosure without an 
obligation of confidentiality. 

b) Is or becomes publicly known through no unauthorized act of the Receiving 
party.  

c) Is rightfully received from a third party without restriction and without breach of 
this agreement. 

d) Is independently developed by the Receiving party without use of the other 
party’s Confidential Information and is so documented. 

e) Is disclosed without similar restrictions to a third party by the Party owning the 
confidential information. 

f) Is approved for release by written authorization of the disclosing party; or 
g) Is required to be disclosed pursuant to any applicable laws or regulations or any 

order of a court or a governmental body; provided, however that the Receiving 
party shall first have given notice to the Disclosing Party and made a reasonable 
effort to obtain a protective order requiring that the confidential information and 
/ or documents so disclosed used only for the purposes for which the order was 
issued. 
 

3.4 This Non-Disclosure clause shall be binding during the period of agreement. Upon 
expiration or termination as contemplated herein the Receiving party shall immediately 
cease any or all disclosures or uses of confidential information and at the request of the 
disclosing party, the receiving party shall promptly return or destroy all written, graphic 
or other tangible forms of the confidential information and all copies, abstracts, extracts, 
samples, note or modules thereof. The obligations of the receiving party respecting 
disclosure and confidentiality shall continue to be binding and applicable without limit 
until such information enters the public domain. 

 

3.5  Title and Proprietary Rights - Notwithstanding the disclosure of any confidential 
information by the Bank to the Vendor, the Bank shall retain title and all intellectual 
property and proprietary rights in the confidential information. No license under any 
trademark, patent or copyright or application for same which are or thereafter may be 
obtained by the Vendor is either granted or implied by the conveying of confidential 
information. 

 

3.6 Return of Confidential Information - Upon written demand of the disclosing party, the 
receiving party shall (I) cease using the confidential information (ii) return the confidential 
information and all copies, abstracts, extracts, samples, note or modules thereof to the 
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disclosing party within seven (7) days after receipt of notice and (iii) upon request of the 
disclosing party, certify in writing that the receiving party has complied with the 
obligations set forth in this paragraph. 

 

3.7 The Vendor shall not make news releases, public announcements, give interviews, 
issue or publish advertisements or publicize in any other manner whatsoever in 
connection with this Agreement, the contents / provisions thereof, information relating 
to this Agreement or information received under this Agreement, the Purpose, the 
Confidential Information or other matter of this Agreement, without the prior written 
approval of the Bank. 

 

3.8 The Vendor shall not reverse-engineer, de-compile, disassemble, or otherwise interfere 
with any software disclosed hereunder. 

 

4. Delivery / Installation and penalty for delay  
 

4.1 Delivery and installation of Fire Alarm Systems should be done within 120 days from 
date of placing of work order if any additional days are required for completing the job, 
the vendor may approach the Bank through e-mail with justification. Bank may grant an 
extension of maximum 30 days in response to such a request based on its merit. In the 
event of the gadgets not being delivered, installed, tested and commissioned within the 
scheduled period of completion, including extension if any granted, a penalty of 
Rs.10000.00 for each week or part thereof for the delay, subject to maximum amount of 
Five (5) percent of the total consideration will be charged to vendor. This amount of 
penalty so calculated shall be deducted at the time of making final payment after 
successful installation and commissioning of Security gadgets. 

 

4.2 In event of installation and commissioning not being completed in 90 days beyond the 
stipulated 120 days, the Bank reserves the right to cancel the Work Order and/ or AMC 
and forfeit the Security money deposit. In the event of such cancellation, the vendor is 
not entitled to any compensation. Please note that the installation schedule shall be 
followed strictly as stipulated. Any delay shall be viewed seriously and penalties shall 
be levied. 

 
5. Delivery Installation and documentation 
 

5.1 Delivery/ Installation of the gadgets shall be made by the Vendor in accordance with the 
system approved and ordered. The below mentioned documents shall be handed over 
by the vendor to the Security Department on handing over the security gadgets. 
Payment will be released after handing of the above-mentioned documents. 
The details of the documents to be furnished by the Vendor are specified hereunder: 
a)  Copies of Vendor's Invoice showing Contract number, Products description along 

with serial number and Part number, quantity, unit price and Total amount. 
b) Manufacturer's warranty certificate, User manuals, CDs etc. wherever applicable. 
c) Detailed as built drawings (three sets) of the system as per actuals 
d) Data sheets of all items installed in the project  
e) Escalation matrix for service related issues  
 

6. Acceptance Procedure: On successful completion of installation, commissioning, 
acceptability test, receipt of deliverables, etc., the installation certificate signed by the Vendor 
and the representative of the Bank will be issued. The date on which such certificate is signed 
shall be deemed to be the date of successful commissioning of the systems. 
 
7. Warranty: The Vendor warrants that the products supplied under the Contract are new, 
unused and as per the approved specifications. The Vendor further warrants that all the 
Products supplied under this contract shall have no defect, arising from design or from any act 
of omission of the Vendor that may develop under normal use of the supplied products in the 
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conditions prevailing in India. Onsite comprehensive warranty for all the hardware components 
including free replacement of spares, parts, kits as and when necessary will be 12 months from 
date of handing over of the project to the Bank.  
 
8. Maintenance & Support - The Vendor shall ensure presence of adequate number of 
trained personnel in Mumbai to provide 24x7 post installation support. During the period of 
contract, if there is shortage of spares due to any reason than the vendor will provide another 
equivalent or higher configuration spares on same rates and terms and conditions subject to 
bank’s acceptance of the same. 
 

8.1 Preventive Maintenance: The VENDOR shall conduct Preventive Maintenance 
(including but not limited to inspection, testing, satisfactory execution of all 
diagnostics, cleaning and removal of dust and dirt from the interior and exterior of the 
gadgets, and necessary repair of the gadgets) of the Fire Alarm System monthly. The 
VENDOR will maintain the system in perfect working order and condition and for this 
purpose will provide repairs and maintenance services. The Vendor shall rectify any 
defects, trouble shooting, faults and failure in the gadgets and shall repair/replace 
worn out or defective parts of the system. VENDOR shall further ensure that the 
system is not down at any time for want of spare parts. 

8.2  Vendor shall provide a complaint number for recording and tracking the complaint 
status on complaints / service requests made by the Bank through written or oral, 
including telephone, notice in defect liability period. The complaint number should be 
sent to the complainant Office by e-mail immediately on receipt of the complaint/ 
service call.  

8.3 Vendor shall ensure that faults and failures intimated by the Bank as above are set 
right within stipulated time line. The vendor should undertake to implement the 
observations / recommendations of any audit conducted by the Bank or external 
agencies and any escalation in cost on this account will not be accepted by the Bank. 

8.4 The contracted Vendor should carry out all installation/maintenance tasks in close 
coordination with the Head Office, Security Department. 

8.5 The Preventive Maintenance and attending complaint related to system’s trouble 
shooting, faults etc. is a part of contract. No Payment shall be made for the purpose 
during the defect liability period.  

8.6 User Maintenance: It is important that the user is aware of the importance of the Fire 
Alarm System and its operations. The Vendor shall offer in-depth training to the 
BMS/Fire Control Room staff after commissioning or during the preventive 
maintenance on the offered solution according to the following: 

a) Provide hands on training to the BMS operators; 
b) Train BMS operators/ Firemen on operations of the system including special 

features, data retrieval, troubleshooting & routine maintenance of gadgets; 
c) The training shall be conducted by the vendor within the office premises; 
d) Educate the staff about the reporting channels of faults, as soon as these are 

discovered. 
 
9. Annual Maintenance Contract (AMC): The Newly installed Addressable Fire Alarm 
System will be under Comprehensive Replacement warranty of ONE year from the date of 
handover of the system after commissioning. No charges will be payable during the warranty 
period for any on-call visit during defect liability period. The vendor shall ensure that any repair/ 
replacement due to manufacturing defect or inappropriate / wrong handling/ service by the 
technician of the vendor during the warranty period should be carried out free of charge. 
Charges for AMC will be payable post the Warranty Period only. 

9.1 The system shall be covered under non-comprehensive Annual Maintenance 
Contract which will entail monthly maintenance visits. The AMC visit will be construed 
to have been done only when the system is found to be functioning properly. Vendor 
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shall keep sufficient standby spares of essential kits or parts of the gadgets all the 
time, as may be required to keep the downtime minimal.  

9.2 The contact details of service center, technicians and Manager i.e. telephone 
numbers, Mobile No., Fax No., E-Mail id, or service focal point(s) to be provided to 
the Security Department. In case, there is any change, updated list should be 
submitted to the Bank immediately. 

 

9.4 AMC Reports: AMC Vendor shall prepare THREE copies of the visit report and each 
report will be counter signed by an officer from the Security Department. One copy 
will be handed over to the HO, Security Department, second copy to be retained by 
the vendor and Third copy will be sent along with invoice of AMC as per the payment 
periodicity i.e. quarterly.  

 
10. Security: All the employees of the Vendor/ OEM must always carry/display their identity 
cards for authentication without which they will not be allowed entry in the Bank. VENDOR 
agrees that his personnel will at all times comply with all security regulations in effect from time 
to time at the Bank's premises and externally for materials belonging to the Bank. 
 
11.  Payment terms for new installation: Payment against the contract shall be made by 
Head Office, Security Department. Payments will not be released for any part-shipment or 
short-shipments. No advance shall be paid at the time of placing the work order.  
 
12. Payment schedule for AMC contract: There will be 36 Monthly visits for the AMC and 
25% of the annual AMC amount shall be payable for each quarter, subject to satisfactory 
completion of maintenance work. Payment of AMC bills will be made by Head Office, Security 
Department after the end of the quarter on a quarterly basis. Advance Payments or requests 
thereof shall not be entertained. 
 
13. Amendment in contract - No variation in or modification of the terms of the Contract shall 
be made, except by written amendment, signed by the parties. 
 
14. Delays and defaults in vendor’s performance:  

14.1 Delivery, installation, commissioning of the Products/Solution and performance of 
Services shall be made by the Vendor within the timelines prescribed. If at any time 
during performance of the Contract, the Vendor encounter conditions impending timely 
delivery of the Products and performance of Services, the Vendor shall promptly notify 
the Bank in writing of the fact of the delay, its likely duration and its cause(s). As soon 
as practicable after receipt of the Vendor's notice, the Bank shall evaluate the situation 
and may, at its discretion, extend the Vendors' time for performance, with or without 
liquidated damages, in which case, the extension shall be ratified by the parties by 
amendment of the Contract. 

 
14.2 Except as provided in the above clause, a delay by the Vendor in the performance of 

its delivery obligations shall render the Vendor liable to the imposition of liquidated 
damages, unless an extension of time is agreed upon without the application of 
liquidated damages. 

 
15. Vendor’s obligation 

15.1 The vendor will be responsible for arranging, procuring all relevant permissions/ Road 
Permits etc. for transportation of the gadgets to the location where installation is to 
be done. The Bank would only provide necessary letters for enabling procurement of 
the same. The Vendor shall obtain all requisite permission from local Government 
Authority as applicable for installation of Fire Alarm System 
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15.2 The Vendor will abide by the job safety measures prevalent in India including the 
insurance coverage of its staff and will indemnify the Bank from all demands or 
responsibilities arising from accidents or loss of limb or life, the cause of which is the 
Vendor's negligence or during performance of any work (SITC or AMC) in the Bank. 
The Vendor will pay all indemnities arising from such incidents and will not hold the 
Bank responsible or obligated for any such incidents. 

15.3 The Vendor shall issue Photo-Identify Cards to all its employees who would be 
deployed for the survey /installation / maintenance or any other job for the system. 
The Photo-Identify Cards shall be signed by the employee concerned, the authorized 
signatory of Vendor. Photo copy of such Photo-Identity Cards to be deposited with 
the Security Department. 

 
16. Termination for default:  

16.1  The Bank, without prejudice to any other remedy for breach of Contract, by a written 
notice of not less than 30 days sent to the Vendor, may terminate the Contract in 
whole or in part if 
a) If the Vendor fails to deliver any or all of the services within the period(s) specified 

in the Contract, or within any extension thereof granted by the Bank; or 
b) If the vendor fails to perform any other obligation(s) under the contract; or 
c) Laxity in adherence to standards laid down by the Bank; or 
d) Discrepancies/deviations in the agreed processes or 
e) Violations of terms and conditions stipulated in this document. 

 

16.2 If the contract is terminated under any termination clause, the vendor shall handover 
all documents/ executable/ Bank's data or any other relevant information to the Bank 
in timely manner and in proper format as per scope of this tender document and shall 
also support the orderly transition to another vendor or to the Bank. During the 
transition, the Vendor shall also support the Bank on technical queries/ support on 
process implementation. 

 

16.3 In case the contracted vendor backs out and refuses to work, the Security Deposit 
shall be forfeited, empanelment with the Bank terminated and the vendor will be 
debarred for 03 years from taking part in the future tenders floated by the bank in 
similar nature of work. The Bank's right to terminate the Contract will be in addition to 
the penalties / liquidated damages and other actions as deemed fit. 

 

16.4 In the event of failure of the Vendor to render the Services or in the event of 
termination of agreement or expiry of term or otherwise, without prejudice to any other 
right, the Bank at its sole discretion may make alternate arrangement for getting the 
Services contracted with another vendor. In such case, the Bank shall give prior 
notice to the existing Vendor. The existing Vendor shall continue to provide services 
as per the terms of contract until a “New Vendor” completely takes over the work. 
During the transition phase, the existing Vendor shall render all reasonable 
assistance to the new Vendor within such period prescribed by the Bank, at no extra 
cost to the Bank, for ensuring smooth switch over and continuity of services." 

 
17. Force majeure 

17.1 Notwithstanding the provisions of T&C, the Vendor shall not be liable for forfeiture of 
its performance security, liquidated damages, or termination for default if and to the 
extent that the delay in performance or other failure to perform its obligations under 
the Contract is the result of an event of Force Majeure. 

17.2 For purposes of this clause, "Force Majeure" means an event beyond the control of 
the Vendor and not involving the Vendor's fault or negligence and not foreseeable. 
Such events may include, but are not restricted to, acts of the Bank in its sovereign 
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capacity, wars or revolutions, fires, floods, epidemics, quarantine restrictions, and 
freight embargoes. 

17.3 If a Force Majeure situation arises, the Vendor shall promptly notify the Bank in writing 
of such condition and the cause thereof. Unless otherwise directed by the Bank in 
writing, the Vendor shall continue to perform its obligations under the Contract as far 
as is reasonably practical, and shall seek all reasonable alternative means for 
performance not prevented by the Force Majeure event. 

 
18. Termination for insolvency: The Bank may, at any time, terminate the contract of the 
L1 Bidder with notice if the said Bidder/s becomes Bankrupt or otherwise insolvent. It is 
incumbent on the L1 bidder/s to advise the bank in this regard. In case it comes to the banks 
notice that the L1 Bidder has become insolvent and the same has not been informed to the 
bank then the Bank reserves the right to invoke forfeiture of the Security Deposit of the bidder 
for that ongoing contract as applicable and terminate the contract immediately without any 
notice. 
 
19. Termination for Convenience: The Bank, by written notice sent to the Vendor, may 
terminate the Contract, in whole or in part, at any time for its convenience. The notice of 
termination shall specify that termination is for the Bank's convenience, the extent to which 
performance of the Vendor under the Contract is terminated, and the date upon which such 
termination becomes effective. 
 
20. Resolution of disputes 

20.1 All disputes or differences whatsoever arising between the parties out of or in 
connection with this contract or in discharge of any obligation arising out of the 
Contract (whether during the progress of work or after completion of such work and 
whether before or after the termination of this contract, abandonment or breach of 
this contract), shall be settled amicably. If, however, the parties are not able to solve 
them amicably, either party (THE BANK or Vendor), should give written notice to other 
party clearly setting out there in specific dispute(s) and/or difference(s) or shall be 
referred to a sole arbitrator mutually agreed upon, and the award made in pursuance 
thereof shall be binding on the parties. In the absence of consensus about the single 
arbitrator, the dispute may be referred to joint arbitrator; one to be nominated by each 
party and the said arbitrators shall nominate a presiding arbitrator, before 
commencing the arbitration proceedings. The arbitration shall be settled in 
accordance with the applicable Indian Laws. Any appeal will be subject to the 
exclusive jurisdiction of courts at Mumbai. 

 

20.2 The Vendor shall continue work under the Contract during the arbitration proceedings 
unless otherwise directed by the Bank or unless the matter is such that the work 
cannot possibly be continued until the decision of the arbitrator is obtained. Arbitration 
proceeding shall be held at Mumbai, India, and the language of the arbitration 
proceedings and that of all documents and communications between the parties shall 
be in English." 

 
21. Jurisdiction 
  

21.1 Applicable Law: The Contract shall be interpreted in accordance with the laws of the 
Union of India and shall be subject to the exclusive jurisdiction of courts at Mumbai. 
All dispute arising out of or connected with this contract shall be instituted in the Court 
of competent jurisdiction situated at Mumbai. 

 

21.2 Saving clause: No suits, prosecution or any legal proceedings shall lie against the 
Bank or any employee of the Bank for anything that is done in good faith or intended 
to be done in pursuance of this agreement. 
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22. Governing Language: The governing language shall be English. 
 
23. Address for Notices: A notice shall be effective when delivered or on effective date of 
the notice whichever is later. The following shall be the addresses of the Bank and Vendor. 

 
Bank's address for notice purposes: 
Bank of India,  
Star House-I 
Security Department, 
C-5, G Block, Ground Floor,  
Bandra Kurla complex, Bandra (East) - 400 051. 

 
Vendor's address for notice purposes: 
____________________________________________ 
_____________________________________________ 

 
24. Taxes & Duties 

24.1 The Vendor will be entirely responsible for all applicable taxes of Central / State 
Government license fees, road permits, GST etc. in connection with delivery of 
products at site including incidental services and commissioning. 

24.2 Income / Corporate Taxes in India: The Vendor shall be liable to pay all corporate 
taxes and income tax that shall be levied according to the laws and regulations 
applicable from time to time in India and the price bid by the Vendor shall include all 
such taxes in the contract price. 

24.3 Tax deduction at Source: Wherever the laws and regulations require deduction of 
such taxes at the source of payment, the Bank shall affect such deductions from the 
payment due to the Vendor. The remittance of amounts so deducted and issuance of 
certificate for such deductions shall be made by the Bank as per the laws and 
regulations in force. Nothing in the contract shall relieve the Vendor from his 
responsibility to pay any tax that may be levied in India on income and profits made 
by the Vendor in respect of this contract. 

24.4 The Vendor shall make his own arrangement for the engagement of all labour and 
shall be responsible for regulating their service and work conditions in conformity with 
all Acts, Regulations, Rules or Order of Competent Authority under relevant laws in 
force during the Warranty period. Vendor shall indemnify the Bank from all claims 
relating to Workers/ Staff Salaries, Wages, Overtime, Leave, Provident Fund, ESI, 
Medical Facilities, Gratuity, Bonds or any other claim as applicable and stipulated in 
any Statutory provisions, rules or order of Competent Authority. 

 
25. Liabilities & Indemnities 
 

25.1 Vendor represents and warrants that the supply repair and maintenance service to 
be provided do not violate or infringe upon any patent, copyright, trade secret, or other 
proprietary right of any other person or other entity. VENDOR agrees that it will, and 
hereby does, indemnify the Bank from any claim, damages, loss, penalty etc., directly 
or indirectly resulting from or arising out of any breach or claimed breach of this 
warranty. 

25.2 Vendor agrees and hereby keeps the Bank indemnified against all claims, actions, 
loss, damages, reputation loss, costs, expenses, charges, including legal expenses 
(Attorney, Advocates fees included) which the Bank may suffer or incur on account 
of any deficiency in Services rendered by the Vendor or breach of any obligations 
mentioned in clauses hereinabove, including without limitation, breach of 
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confidentiality obligations or any acts of commission / omission on the part of 
employees, agents, representatives or Sub-Contractors of the Vendor. 

25.3 The Vendor agrees to make good the loss suffered by the Bank on first demand made 
by the Bank in this regard which shall be final conclusive and binding on the Vendor. 

25.4 Vendor further undertakes to promptly notify the Bank in writing any breach of 
obligation of the Agreement by its employees or representatives including 
confidentiality obligation and in such an event, the Bank will in addition to and without 
prejudice to any other available remedies be entitled to immediate equitable relief in 
a Court of competent jurisdiction to protect its interest including injunctive relief. 

25.5 The Vendor shall indemnify and keep fully and effectively indemnified the Bank 
against any fine or penalty levied on the Bank for improper payment of tax for the 
reasons attributable to the Vendor. 

25.6 The Vendor hereby undertakes the responsibility to take all possible measures, at no 
additional cost, to avoid or rectify any issues which thereby results in non-
performance of software/hardware deliverables within reasonable time. The Bank 
shall report as far as possible all material defects to the Vendor without undue delay. 
The Vendor also undertakes to co-operate with other service providers thereby 
ensuring expected performance covered under scope of work. 

25.7 Nothing contained in this Agreement shall impair the Bank's right to claim damages 
without any limitation for an amount equal to the loss suffered for non-performance 
of software/ hardware/ any other system. 

 
26. Fraud & Corrupt practices 

26.1 For the purposes of this Clause, the following terms shall have the meaning 
hereinafter, respectively assigned to them: 
a) "Corrupt practice" means offering, giving, receiving, or soliciting, directly or 

indirectly, of anything of value to influence the actions of any person connected 
with the Bank 

b) "Fraudulent practice" means a misrepresentation or omission of facts or 
suppression of facts or disclosure of incomplete facts, in order to influence the 
award of contract 

c) 'Coercive practice" means impairing or harming or threatening to impair or harm, 
directly or indirectly, any person or property to influence any person's 
participation or action during the contract. 

d) "Undesirable practice" means  
(i)  establishing contact with any person connected with or employed or 
engaged by the Bank with the objective of canvassing, lobbying or in any 
manner influencing or attempting to influence; or  

(ii)  having a Conflict of Interest; and 
e) "Restrictive practice" means forming a cartel or arriving at any understanding or 

arrangement among Vendors with the objective of restricting or manipulating a 
full and fair competition. 

26.2 The Vendor and their respective officers, employees, agents and advisers shall 
observe the highest standard of ethics during the contract. Notwithstanding anything 
to the contrary contained herein, the Bank shall black list for a period of 03 years, 
without being liable in any manner whatsoever to the Vendor, if it determines that the 
Vendor has, directly or indirectly or through an agent, engaged in 
corrupt/fraudulent/coercive/undesirable or restrictive practices in execution of the 
contract 

 
27. Authority to Execute the Contract 
Each person executing this Agreement warrants and represents that he or she has the authority 
to enter into this Agreement on behalf of the party whose name appears below their signature.  
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In witness whereof, the parties hereto have set their hands through their authorized signatories. 
 
SIGNED: 
For and on behalf of BANK ………….. 
 
 
For and on Behalf of 
M/s. …………..   
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APPENDIX-C 
 

 1.1 PRODUCT – MAKE & MODEL 

Sr. Equipment/Device Make Model 

1 Addressable Fire Alarm Panel Honeywell-Notifier NFS2-3030 

2 Addressable Intelligent 
Thermal(Heat) Detector 

Honeywell-Notifier FST-951 

3 Addressable Multisensor Detector Honeywell-Notifier FSP-951T 

4 Fire Sounder with strobe Honeywell-System Sensor P2RL 

5 Addressable Manual Call Point Honeywell-Notifier NFX/MCP/GLASS 

6 Addressable Control Module Honeywell-Notifier FCM-1 

7 Addressable Monitor Module Honeywell-Notifier FMM-1(A) 

8 Addressable Relay Module Honeywell-Notifier FRM-1 

9 Isolator Module  Honeywell ISO-X 

10 Response Indicator Honeywell-Notifier RI/007H 

11 Junction Box  Maths or BIS Approved BIS Approved 

12 Electrical Cable Polycap/Finolex/RR kabel BIS Approved 

 
1.2 GENERAL  

A. The fire alarm system shall comply with requirements of NFPA Standard and 
Underwriters Laboratories Inc. (UL) – USA for Protected Premises such as High rise 
building. The specifications and standards listed below form a part of this specification. 
The system shall fully comply with the latest issue of these standards, if applicable:- 
 
National Fire Protection Association (NFPA) - USA 

NFPA 1 Fire Code 

NFPA 70 National Electric Code 

NFPA 70 E Electrical Safety in Work Place 

NFPA 75 Fire Protection of Information Technology Equipments 

NFPA 90A Air Conditioning Systems 

NFPA 92A Smoke Control Systems 

NFPA 92B Smoke Management Systems in Malls, Atria, Large Areas 

NFPA 72 National Fire Alarm and Signaling Code  

NFPA 101 Life Safety Code 

NFPA 204 Smoke and Heat Venting 

 
Underwriters Laboratories Inc. (UL) - USA: 

UL 268, 7th Edition Smoke Detectors for Fire Protective Signaling Systems 

UL 864, 10th Edition Control Units for Fire Protective Signaling Systems 

UL 217 Smoke Detectors, Single and Multiple Station 

UL 228 Door Closers - Holders for Fire Protective Signaling Systems 

UL 268A Smoke Detectors for Duct Applications 

UL 521 Heat Detectors for Fire Protective Signaling Systems 

UL 464 Audible Signaling Appliances 

UL 1481 Power Supplies for Fire Protective Signaling Systems 

UL60950 Safety of Information Technology Equipment 

 
B. The facility shall have an emergency voice alarm communication system. Digitally 

stored message sequences shall notify the building occupants that a fire or life safety 
condition has been reported.  Message generator(s) shall be capable of automatically 
distributing up to eight (8) simultaneous, unique messages to appropriate audio zones 
within the facility based on the type and location of the initiating event.    
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C. A new intelligent reporting, microprocessor controlled fire detection system shall be 

installed in accordance to the project specifications, drawings and relevant standards. 
 

D. The proposed product shall not restrict the buyer to one single organization, nor shall it 
require any proprietary dongle or other programming tools for after sales & maintenance 
activity. 
 

E.  The fire alarm control panel, voice panels and any head-end equipment shall have a 
manufacturer’s warranty of a minimum of 12 months.   

 
1.3  INSTALLATION 

A. Vendor shall carry out a thorough inspection of the building and prepare a detailed 
drawing, which shall be approved/ verified by Bank team before execution of work. 
Vendor will provide as built drawing (3 sets) with Data Sheet after SITC of Fire Alarm 
as approved above. 

B. The installation has to be done in the operational office which entails that the 
cabling/installation work in office area shall be allowed to be undertaken only in in 
non-working hours/holidays in consultation with Security/Estate Department of the 
Bank in order to ensure that no disruption of work/business takes place. The vendor 
may prepare and plan their manpower/ technical team accordingly. 

C. The existing fire alarm system, its accessories and cabling will also be required to be 
removed by the vendor to the possible extent and this will be part of the installation 
process.  

D. Installation shall be in accordance with the NEC, NFPA 72, local and state codes, as 
shown on the drawings, and as recommended by the Original Equipment 
Manufacturer (OEM). 

E. All conduit, junction boxes, conduit supports and hangers shall be concealed in 
finished areas and may be exposed in unfinished areas. Smoke detectors shall not 
be installed prior to the system programming and test period. All measures shall be 
taken to protect all accessories from physical damage, dust accumulation etc. 

F. All fire detection and alarm system devices, control panels and remote annunciators 
shall be flush mounted when located in finished areas and may be surface mounted 
when located in unfinished areas. 

G. The SLC and device installation details will be provided after SITC of Fire Alarm 
System. 

H. All devices should be tagged / labelled appropriately with device number, Loop 
number and Zone number for easy identification. 

I. The submission of data sheet of all devices, warranty certificates (minimum one year), 
complete operation and maintenance user manuals and drawings will be the part of 
handing over the document of all devices  

J. Submit panel configuration and interconnection of modules and all other data as 
required to make product suitability with Fire Alarm System. 

 
1.4 TESTING 

A. Before energizing the cables and wires, check for correct connections and test for 
short circuits, ground faults, continuity, and insulation. 

B. Open initiating device circuits and verify that the trouble signal actuates. 
C. Open and short signaling line circuits and verify that the trouble signal actuates. 
D. Open and short notification appliance circuits and verify that trouble signal actuates. 
E. Ground all circuits and verify response of trouble signals. 
F. Check presence and audibility of tone at all alarm notification devices. 
G. Check installation, supervision, and operation of all intelligent smoke detectors using 
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the walk test. 
H. Each of the alarm conditions that the system is required to detect shall be introduced 

on the system. Verify the proper receipt and the proper processing of the signal at 
the FACP and the correct activation of the control points. 

I. When the system is equipped with optional features, the manufacturer's manual shall 
be consulted to determine the proper testing procedures. This is intended to address 
such items as verifying controls performed by individually addressed or grouped 
devices, sensitivity monitoring, verification functionality and similar. 

 
1.5 INSTRUCTION & TRAINING 

A. Instruction shall be provided as required for operating the system. Hands-on 
demonstrations of the operation of all system components and the entire system 
including program changes and functions shall be provided. 

B. The contractor and/or the systems manufacturer's representatives shall provide a 
typewritten "Sequence of Operation." 

C. A suitable Training for Fire Control Room and Building Management operator shall 
be arranged and trained for operation & maintenance and trouble shooting of Fire 
alarm System. The training shall be such an exhaustive that operator can make the 
system healthy and working condition all time. 

D. The Vendor shall provide a refresh training program during maintenance in every 
quarter in defect liability period without any additional charges to ensure system 
healthy condition. 
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Appendix-D 
 

(Format for Work Experience Certificate from the Client) 
On the letter head of the Client duly signed by the authorized Officer 

 
PERFORMANCE CERTIFICATE 

 
Name and Address of the client:  __________________________________ 

Name of the Agency: M/s__________________________________________________  

 

Sl. 
No. 

Description Details 

a) Name of Work & Location  

b) Work Order No & Issue Date    

c) Value of Work Order (Excluding GST)  

d) Date of Work Completion  

e) 
Actual value of work order, if any deviation after 
completion of work  

 

f) Quality of Work (Good/Satisfactory/Poor) 
 

g) Remarks, if any  
 

 

 

Signature of the Officer with Office Seal:        

  

Name of the Officer: 

Designation:  

Phone/ Mobile No:  

Email Id:  
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Appendix- E 

(Format for Performance Certificate on AMC from existing Client) 
On the letter head of the Client duly signed by the authorized Officer 

 
Details of Running AMC Contract of AMC of Fire Alarm System 

 
 

Sr. Particulars Details 

1 Name of the Client  

2 Address of the client  

3 Name of authorized officer as 
referee  

 

Designation   

Office Phone Number  

Mobile Number  

E-mail address   

4 Name of work   

5 Address of client office/site where 
AMC contract is in currency 

 

6 Work order no. & Issue Date  

7 Value of AMC contract  

8 Period of the AMC contract   

9 Quality of service  
(Good/Satisfactory/Poor) 

 

 
 
 

(Signature) 

Name of the Authorised signatory 

Designation 

Company seal 

 

Date    
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Appendix-F 
 

(on letter head of the applicant) 
 
 
 

The AGM & CSO 
Security Department 
Bank of India  
Head Office, Star House, 
C-5, G-Block, 
Bandra Kurla Complex 
Bandra East 
Mumbai 400051 
 

DECLARATION 
 
We, [Company Name], having registered address at ______________________________ 

________________________________, hereby solemnly declare that our company/agency is 

not currently blacklisted, debarred or suspended by any Government Department, Public 

Sector Undertaking or any Regulatory Authority in India. 

 

We further confirm that we have not been involved in any instance of violation of laws related 

to statutory compliances with EPF / ESI or instance of evasion of Goods and Services Tax or 

Income Tax during last three years. 

 

We undertake to immediately disclose any such information on blacklisting, debarment or 

suspension, penal action by the Government/regulators for violation/non-compliance with 

EPF/ESI statutory compliances or tax evasion, if it occurs during the work contract including 

with AMC of Fire Alarm System. 

 

We also understand that if an undisclosed instance of violation/penalty/tax evasion as 

mentioned above comes to the notice of the Bank, the contract will be terminated without any 

notice in addition to imposition of penalty, if any, as per the terms of empanelment/contract. 

 

 

(Signature) 

Name of the Authorised signatory 

Designation 

Company seal 

 

Date    

 

 


